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Overview

» What is LiDAR?
» Where can | find publically available LiDAR?
» How can | process LiDAR?

» How can |l use LiDAR to assess stream restoration
project sites?
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What is LiDAR?

» Light Detection ﬂ@ , \\\\\\

and Ranging =
LiDAR The IMU (inertial measurement l X
unit) gives the precise orientation E
»  Aerial LIDAR of the scanner GPS Y

»‘lhe GPS gives the precise

location of the scanner

Scanning (ALS) E

The laser scanner emits infrared
pulses which reflect off the
surface of the earth and objects
on it. The returned pulses are
captured and recorded.

i
I




Uses of LiDAR

vVvvyvy

v

Highly detailed maps of topography

Identify anthropogenic disturbances in watershed
Identify landslides that could impact restoration
Identify areas of erosion within watershed

Identify areas that may need special consideration
during fieldwork

Create surfaces for design purposes
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Where to Find Public Available LiDAR

vy

A google search is going to be your best friend for
finding data

USGS - The National Map
(https://viewer.nationalmap.gov/basic/)

Open Topography (https://opentopography.org/)

GIS Data Clearinghouses
= Often hosted by a university, state or county agency
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Public Available LiDAR

vvyywvyy

LiDAR is not available everywhere
Some states have statewide LiDAR
Some states only have LiDAR for specific areas

LIDAR data can vary in resolution
=Sub-meter resolution to 5 meter resolution
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Types of LIDAR Data

» Comprehensive Digital Elevation Model (DEM)
= Includes all returns

» Bare Earth DEM

= All returns removed except for ground returns
= When it comes to DEMs this is what you want

» LAS files

= Point cloud that includes all data points

= Can be filtered
= This is the ultimate dataset if you can process it

Civil & Environmenta | Consultants, Inc.



How to Process LAS files

5] laszip - lossless compression of LiIDAR data

o (B R

L browse ... +J
C filter ... +
C transform ... +J
C projection ... +
C overlays .. +

LAS version: 1.X

# points:

point type: point size:
X

y:

7

compression:

source ID: created:

# VLRs:
global_encoding:
header size:  offset:
# of 1st returns:

# of Znd returns:

# of 3rd returns:

# of 4th returns:

# of S5th returns:
offset x y z:

scalexy z:

no projection

£ 1 job on 8 cores +|J
¢ selected file only
& process all files
[~ merge files into one

C_output .. +F
[~ verhose

VIEW ]
sample points:|5000000

COMPRESS
" native LAS 1.4 extension
[~ auto-create *lax files
I~ append *lax to *laz files

L 2 options + |1
C_other options ... +|1

DECOMPRESS I

= LAS

 ASCI

W (%)

W ()

¥ ()

I (ijntensity.

I (ryeturn number
= (rmjumber of returns
[T (c)lassification
I~ scan (ahgle
[T GPS (fjime

G| riore atirbutess, Hf
L atfribites .. + |1
parse string:fxyz
separator[space. 5

README <Q=UIT

LICENSE clip input
LAStools (c) 2017 (-\ 35 > “ pick Iower [eftx:{ 0 Upper right ID use souare tile |
b= "\anen’.' ":39”19 = \r\}- N disable’ | lower [eft 5«:]0 upper right y:[0 tile size: [1000
y Martin Isenburg
(varslon 74| ese RO MOvE I <o e i

» LAS files are often
compressed into
LAZ files

" Free software is needed
to extract the LAS data
= LASzip or LAStools can
! be used to extract data
(https://rapidlasso.com/

laszip/)
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How to Process LAS files

ArcToolbox A X
[l ArcToolbox

&= @ 3D Analyst Tools

& &P Analysis Tools

& & Cartography Tools

s @ Converion Tl » ArcMap is used to process the

& & Data Interoperability Tools

= & Data Management Tools d t
[+ & Data Comparison a a

[ & Distributed Geodatabase

& & Domains =Open Source GIS programs and

i & Feature Class

i e AutoCAD can also be used but with

- e potentially different results
# & Generalization

@ & Geodatabase Administration > ArcTooIbox > Data Management

[ & Graph

o Tools > LAS Dataset > Create LAS

=) &- LAS Dataset

Q‘r Create LAS Dataset taset) D a t a s et

"’».\\, LAS Dataset Statistics
"’.\\, LAS Point Statistics as Raster

"v,.\\. Remove Files from LAS Dataset
1 B | avere and Tahle Viewe

m

9
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#, Create LAS Dataset fFoe L4 b - - TEFve . E‘E‘g

- -

Store Relative Paths

Input Files
(optional)

LAS Dataset —

P:\2017\175-011\-GIS\Data\L IDAR\LAS\20130316_scdnr_spartanburg_7046_01.las
P:\2017\175-011\-GIS\Data\LIDAR . AS\20130316_scdnr_spartanburg_7027_03.las
P:\2017\175-011\-GIS\Data\LIDAR\LAS\20130316_scdnr_spartanburg_7027_01.las
P:\2017\175-011\-GIS\Data\L IDAR\LAS\20130316_scdnr_spartanburg_7034_02.las
P:\2017\175-011\-GIS\Data\LIDAR\LAS\20130316_scdnr_spartanburg_7054_01.las
P:\2017\175-011\-GIS\Data L IDAR\LAS\20130316_scdnr_spartanburg_7055_03.las where the LAS dataset and
P:\2017\175-011\-GIS\Data\LIDAR\LAS\20130316_scdnr_spartanburg_7054_02.las its associated data will be

> c h L AS f H I P:\2017\175-011\-GIS\Data\LIDAR\LAS\20130316 _scdnr_spartanburg_7046_04.las L telocaladtin tha G bystani
oose I es | P ——————————————————— —rT s using the same relative

location to one another.

Specifies whether lidar files
and surface constraint
features will be referenced
by the LAS dataset through
relative or absolute paths.
Using relative paths may
be convenient for cases

[T Include Subfolders (optional)

» Use appropriate oumtsoe

C:\Users\mdenicola\Documents\ArcGIS\c20130316_scdnr_spartanburg_1.lasd be used for the data

coordinate system | sesc e - chreedtibe

the default.
Checked—Relative
paths will be used
for the data
referenced by the
LAS dataset.

e Unchecked—

| F O u n d i n m eta d ata ‘ Input Features Height Field Type

» Best practice to
compute statistics
and store relative | - i

Coordinate System (optional)

p a t h s NAD_1983_NSRS2007_StatePlane_South_Carolina_FIPS_3900_Ft_Int

Create PRJ For LAS Files (optional)
NO_FILES -

« =[x+ @)

Q)

[¥] Compute Statistics {optional)

Store Relative Paths (optional)

[ ok [ cancel | [environments...| [ <<tiderelp | [ ToolHep |




Unfiltered LAS Dataset

File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help

X |® | b~ 1250 Ml /o L1 3 I N el A U7 g Drawing~ K () & O~ A~ 7% | (8 Swe721 BT T B IUA-N-2-
R Y ] bl WS [@ stmord 280k ~] %Pl 5  Georeferencing - '

Table Of Contents 1 x
398 g f
B
M Property
™ Field Data
= [ SC_LIDAR_dataset_Watershed.lasd
Data percentage: 7.8
LAS point elevation
558.868 - 2242.028
540.026 - 558.868
521185 - 540.026
502.344 - 521.185
483.502 - 502.344
464.661 - 483.502
+ 445819 - 464.661
+ 426978 - 445819
* 408136 - 426.978
[ 0.01 mi2 delineation
[ 0.001 mi2 delineation
O Flow Accumulation Grid
[ LiDAR DEMs
O USA Topo Maps
O World Imagery

Bl| [sinsou B| [seinies eieeio ] semaumy (]| semadord wiexs 1p3

[uozzas g1l [ Gormeo €| [xeaiooLor

383059.822 -417875.302 Meters
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Filter LAS Dataset

I General I Source | Fitter ISquace Constraints | Display I Symbology‘

° Classification Codes Return Flags
> Fllter LAS dataSEt DAllélasses AII:eturns @30 flag

within layer S 5 oyt
properties i sy
[] 9 water [ Return 1
= Ch OOSG grOU nd (7] 10 Rail [] Return 2 Predefined Settings
classifications i —
= Choose Model M
Key/Reserved if
available
o This classification is
typically surveyed
ground control
points
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Filtered “Bare Earth” LAS Dataset

File Edit View Bookmarks lInset Selection Geoprocessing Customize Windows Help

Osas

QR 11«
Table Of Contents

EHaeBa

Bgx»

[

RO BELUNASS

Data percentage: 74
LAS point elevation
558.968 - 2242028
540.026 - 558 868
521185 - 580026
50234 - 521.185
482,502 - 502348
464,661 - 483 502
445519 - 464 661
426978 - 45819
408136 - 426.978

@ O 001 mi2 delineation
& [ 0001 ma2 delinestion
@ [) Flow Accumulation Grid
w B4 LiDAR DEMs

(& O USATopo Maps

& O World Imagery

* | b+ 1250 R EEEED
D Rg &

ol

Drawing~ W ) %5 (L~ A - ¢

© [@ Swen218T

[ 5 - Georeferencing -

]

saimea ajeal) B[ seinouny (L] se0a00id 4oIeNS 1P

snsea B

000 2v @ |

yaieas ol | tojees Gl

383060483 -417344.149 Meters L
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Convert Filtered LAS Dataset to Raster

» ArcMap > ArcToolbox
> Conversion Tools >
To Raster > LAS
Dataset to Raster

ArcToolbox

i ArcToolbox
] @ 3D Analyst Tools
& & Analysis Tools
# & Cartography Tools
= @ Conversion Tools
[ &y Excel
& & From GPS
@ & From KML
@ & From PDF
i & From Raster
@ & From WFS
& & JSON
@ & Metadata
@ & To CAD
@ & To Collada
@ & To Coverage
@ & To dBASE
i & To Geodatabase
i & To GeoPackage
@ & ToKML
= & To Raster
#, ASCI to Raster
"-“ DEM to Raster
#, Feature to Raster
& FhaiioBacia
#, Multipatch to Raster
"'\ Point to Raster
"{-«Q Polygon to Raster
"-“ Polyline to Raster
3’ Raster To Other Format (multiple)
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Convert Filtered LAS Dataset to Raster

» Input filtered LAS Dataset

»  Use Triangulation Interpolation
Method

= Linear Interpolation Method is
quickest

= Nearest Neighbor Interpolation
Method is more accurate

= No Thinning of points

»  Output Datatype is Float
»  Sampling Type is Cell Size

v

Sampling Value and Z Factor
should be 1

This process can take a while

vy

Output raster may be very large
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————

C:\Users\mdenicola\Documents\ArcGIS\Default.gdb\SC_LIDAR _dat1

Value Field (optional)
ELEVATION

Interpolation Type (optional)
_) Binning

AVERAGE

LINEAR

il @) Triangulation

1 Method (Optional)

(Lmear -]
Point Thinning Type (Optional)

[No_THnmG ~

MAXIMUM

Output Data Type (optional)
FLOAT

Sampling Type (optional)
CELLSIZE

Sampling Value (optional)

Z Factor (optional)

[N =&
LAS Dataset to Raster - - s -
InputLAS Dataset LAS Dataset to
[ SC_LIDAR_dataset_Watershed.lasd ~] Raster
Output Raster

Creates a raster using
elevation, intensity, or RGB
values stored in the lidar
points referenced by the
LAS dataset.

OK

][ Cancel ][Envnronments...H << Hide Help l

[

Tool Help




Bare Earth DEM

5 i Drawing~ R () &80 - A - [) Swis721 BT +10 +vB I U A-»- 2.

IGERO 3 Editor~ | .
5 E _ [& stmord_2s0k ~1%8 il - | Georeferencing~
& Fiag ;

S

Create a slope
map of the DEM

Allows for close
examination of
dataset

[sunsax B]| [saimieas ateaso B[ sanquy [ samadoid Gaiays up3

2
g
s
4
E

[yareas Gl [ Gorered ]

383062.467 -417934.171 Meters
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Bare Earth DEM

West Virginia LIDAR
* Created from
Bare Earth DEM

r74 7 ¥ 7
/ A &
[ N B/
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Bare Earth DEM
PR

South Carolina LiDAR
* Created from
filtered LAS
Dataset

LEL
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Bare Earth DEM

iDAR

Created from

f

Indiana L

iltered LAS
Dataset
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Landslide \

.;‘(4?¢1

LoQging Roads

N

o s e “
Legend

o
—

_DELINEATED STREAMS

& - EPHEMERAL
INTERMITTENT
PERENNIAL

SCALE IN FEET
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Using DEM to Create Flow Accumulatlon Grid

» ArcToolbox >
Spatial Analyst >
Hydrology

= Bare Earth DEM is
used to create a Fill
raster

= Fill raster is used to
create a Flow
Direction raster

= Flow Direction
raster is used to
create a Flow
Accumulation

Ractar

ATIb

[ ArcToolbox
&P 3D Analyst Tools
3] @ Analysis Tools
@ & Cartography Tools
= @ Conversion Tools
# &P Data Interoperability Tools
# &P Data Management Tools
&9 Editing Tools
# & Geocoding Tools
@ &P Geostatistical Analyst Tools
@ &P Linear Referencing Tools
3] @ Multidimension Tools
# & Network Analyst Tools
3] @ Parcel Fabric Tools
& &P Schematics Tools
@ & Server Tools
= & Spatial Analyst Tools
[ & Conditional
[ & Density
i & Distance
= & Extraction
@ & Generali
@ & Gro dwater
SR Hyd ology
y, Basin
Step 1 ‘ . Fill
Step 3 " . Flow Accumulation
Step 2 "\\ Flow Direction
#, Flow Length
# Sink
#, Snap Pour Point
#, Stream Link
#, Stream Order
#, Stream to Feature
#, Watershed
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Understanding a Flow Accumulation Grid

» Flow accumulation raster represents the number of cells

that flow to a particular cell

» The processing gets more complicated from here

=You need to have a basic understanding of map algebra

» | convert my flow accumulation grid from number of

cells to square miles to better understand drainage area

=You could also make an excel “calculator” to convert number of
cells to square miles
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Understanding a Flow Accumulation Grid
» Basic steps to convert flow accumulation grid from number
of cells to square miles

= Cell Size (ex. 1 ft?)

= Area of a cell converted to mi?—

o 1 ft?is equal to 0.00000003587006 mi?
= ArcToolbox > Spatial Analyst > Map Algebra > Raster Calculator

=
#, Raster Calculator

Map Algebra expression

Layers and variables
<> con0_01mi2
<> floacc1
<> flodir
<Fil

<> 181714 _Slope

Conditional

g
2 I T
[ N [ P T
L)) ]|
o i) i) 2o,

“floacc1™*0.00000003587006

Output raster

v:\Users\mdenicola\Documents\ArcGIS\Default.adb \floac

cmi2 @ ;

OK ] [ Cancel ] [Environmems... ] [ Show Help >> l

multiply flow accumulation by this number
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Understanding Flow Accumulation Grid

» Change symbology of flow accumulation grid to fine
tune the drainage area thresholds

wi i = A 1
Draw raster grouping into ¢ * -
r Fie \ °
ique Val
i Fields
gtrgtgﬁt:g I Value <VALUE> Normalization <None>
Classification
Manual Classes[z v] [ Classify... ]
g E—
Symbol Range Label
[ Jo-o0.01 0-0.01
0.01-13.77012634 0.010000001 - 13.77012634
[] show dass breaks using cell values Display NoDataas | ||+
[]use hillshade effect 7|1
About symbology
[ ok |[ cancel |[ Appy |
- o - Civil & Environmen tal Consultants, Inc.
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Flow Accumulation Grid

» Ideal for smaller tributaries

» Not ideal for large rivers

= HUGE raster needed to calculate
drainage area

= Use in combination with USGS
StreamStats for large rivers

» Great for planning design

parameters based on drainage
area

» Excellent resource for planning %
delineations and estimated
linear footage of streamona [~
project site =

LEGEND

o 2
] ProrerTY BOUNDARY (1,448 ACRES) ld
FLOW ACCUMULATION GRID
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Conclusions

» Public available LiDAR is usually found as bare earth DEMs or
LAS files

= Bare Earth DEMs can be used with little to no processing
= LAS files require careful processing

» Bare Earth DEMs can be used to:

= [dentify various landforms or surficial geology
= Areas of erosion

= Anthropogenic disturbances

= Create flow accumulation grids

= Use for design purposes

= Etc. — the possibilities go on and on
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Questions?

Connect with us!

WWW.cecinc.com
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